
What a great Christmas party!... It was fun seeing new 

old friends.  By that I mean, some persons that had been 

members of TAPCUG more than twenty years ago and 

have decided to return, they were introduced as a visitor 

with the possible intent of joining or rejoining our club.  

Welcome back Old Timers.  We're looking forward to 

you joining us once again. 

 

The Christmas food was superb, both in presentation and 

how well it excited the palate.  It was just the right mix 

of sweets and nutrition.  The rum balls were a great 

addition.  A special thanks to Bill and Cyndie for setting 

things up, also to all those who brought goodies. 

 

Neil Stahfest gave an outstanding presentation on 

Windows 7.  For me it was very timely indeed, 

especially since I am planning to upgrade and replace all 

of my computer equipment with new Hewlett-Packard 

machines, which will include Windows 7, 64 bit 

operating systems.   

 

My plan is to customize the machines to the 

specifications that I desire using HP equipment 

exclusively, thus avoiding incompatibility as much as 

possible.  The modus operandi for selecting vendors is to 

choose three vendors that can provide the configurations 

that I specify, i.e. processor speed, ram memory, hard 

drive capacity, which graphics card etc., to include price 

and delivery and return policy.  Based on my past 

experience, my goal is to get everything right this time. 

 

I'm looking forward to Neil's next presentation in which 

he will explain how to transfer data from XP and Vista 

machines to windows 7 machines. 

 

I want to thank John Wickliffe, the Programs Chairman 

as well as Dick Meier and Carl Fisk for doing such a 

great job in getting presenters booked for our meetings.  

So far we have presenters booked up until May 2010.  It 

looks as if the year 2010 will be a great year for 

programs. 
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Presented by Neil Stahfest 
 

Refreshments by:  

Alice Grenier 

 

Raffle will follow  

Open Labs are every Friday, 10 AM ïNoon at the Lakewood Community Center  
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December Demo Web Site  
 

From:  NEIL STAHFEST  

 

Maggie, 

  

Here's the primary web site that I used 

for the demo videos: 

  

http://windows.microsoft.com/en-us/

windows7/help/videos/getting-around-

the-desktop 

  

I also recommend this one for more info: 

  

http://www.microsoft.com/Windows/

windows-7/videos-tours.aspx?

CMXID=2120_win7.CE9B1664-41D9-

4B0A-BC1C-

99FCD746F4CB&WT.srch=1&CR_CC=

100249569&WT.srch=1&WT.mc_id=Se

arch&CR_SCC=100249569 

  

I tried the sleep/wake-up feature when I 

got home and it seems to work the way 

the video showed.  I think the problem 

that occurred during the demo was due to 

putting the computer to sleep while being 

connected to a projector.  

  

- Neil 

Maggieõs Mailbox 
 
To:  maggiebs@harbornet.com  
Sent:  Wednesday, December 02, 2009 
7:36 PM 
Subject:  Article item for the Data Line 

 

Hi Maggie 

Here is a helpful procedure to use 

when printing something from the 

internet. 

  

Improve the readability of your 

copied text. 

When you want to print something 

from the internet; oftentimes the text 

is so small that itôs hard to read. 

Also, the text is in a light blue color 

that wonôt show up if you donôt have 

a color cartridge in your printer. 

 

Do the following: Highlight the text 

you want to print, and then click Edit 

and Copy. Then open Wordpad or 

Microsoft Word, and Edit then 

Paste.  Highlight the text, change the 

font size, and the color to black. 

Now print your text and it will be 

readable. 

Thanks, I've been doing that for 

years, yet I don't think of it. 

Small tips really are big tips after 

all. Thanks again.   ñ Maggie 

mailto:ncstahfest@msn.com
http://windows.microsoft.com/en-us/windows7/help/videos/getting-around-the-desktop
http://windows.microsoft.com/en-us/windows7/help/videos/getting-around-the-desktop
http://windows.microsoft.com/en-us/windows7/help/videos/getting-around-the-desktop
http://www.microsoft.com/Windows/windows-7/videos-tours.aspx?CMXID=2120_win7.CE9B1664-41D9-4B0A-BC1C-99FCD746F4CB&WT.srch=1&CR_CC=100249569&WT.srch=1&WT.mc_id=Search&CR_SCC=100249569
http://www.microsoft.com/Windows/windows-7/videos-tours.aspx?CMXID=2120_win7.CE9B1664-41D9-4B0A-BC1C-99FCD746F4CB&WT.srch=1&CR_CC=100249569&WT.srch=1&WT.mc_id=Search&CR_SCC=100249569
http://www.microsoft.com/Windows/windows-7/videos-tours.aspx?CMXID=2120_win7.CE9B1664-41D9-4B0A-BC1C-99FCD746F4CB&WT.srch=1&CR_CC=100249569&WT.srch=1&WT.mc_id=Search&CR_SCC=100249569
http://www.microsoft.com/Windows/windows-7/videos-tours.aspx?CMXID=2120_win7.CE9B1664-41D9-4B0A-BC1C-99FCD746F4CB&WT.srch=1&CR_CC=100249569&WT.srch=1&WT.mc_id=Search&CR_SCC=100249569
http://www.microsoft.com/Windows/windows-7/videos-tours.aspx?CMXID=2120_win7.CE9B1664-41D9-4B0A-BC1C-99FCD746F4CB&WT.srch=1&CR_CC=100249569&WT.srch=1&WT.mc_id=Search&CR_SCC=100249569
http://www.microsoft.com/Windows/windows-7/videos-tours.aspx?CMXID=2120_win7.CE9B1664-41D9-4B0A-BC1C-99FCD746F4CB&WT.srch=1&CR_CC=100249569&WT.srch=1&WT.mc_id=Search&CR_SCC=100249569
http://www.microsoft.com/Windows/windows-7/videos-tours.aspx?CMXID=2120_win7.CE9B1664-41D9-4B0A-BC1C-99FCD746F4CB&WT.srch=1&CR_CC=100249569&WT.srch=1&WT.mc_id=Search&CR_SCC=100249569
mailto:maggiebs@harbornet.com
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January  Disk of  the Month  

J a n u a r y  2 0 1 0  

South Sound Adobe 
User Group  
http://www.ssaug.org/ 
 

Meeting will be at Cascade Print, 

3321 S. Lawrence St, Tacoma, 

98409. Be sure to grab a ñbrown 

bagò. We are back to bringing in 

whatever we want to eaté. 5:30 for 

dinner and networking. 6:30 Meeting 

- 9:00 Dismissal 

 

We wanted to announce that the 

Adobe Photoshop Marketplace is 

live.   

 

Adobe Photoshop Marketplace is a 

place where anyone can publish 

information about their Photoshop-

related tools, solutions, or events, 

including details about user groups, 

hardware, software, training (e.g. 

books, DVDôs), events, etc. 

 

Hereôs the official link: http://

photoshopmarketplace.adobe.com 

CleanDesktop - Unlike in Windows XP, Windows 7 or 

Vista, does not include a Desktop Cleanup Wizard, 

which kept track of your usage of the icons on your 

desktop and offered to remove the unused icons every 60 

days.  CleanDesktop is a small, portable, freeware app 

which will help you clean up your unused desktop icons, 

in Windows 7 & Vista.  On running it, it will scan & de-

tect desktop items which have not been used in the last 

30 days and  list them down. You then have an option to 

delete all or some of them.  The unused items are not 

deleted but moved to a folder on the Desktop viz; C: \Us-

ers \username \Desktop \Unused Icons. Alternatively, 

you cans also opt to delete the unused items directly. 

 

 

Magical Jelly Bean Keyfinder is a freeware open 

source utility that retrieves your Product Key (cd key) 

used to install Windows from your registry. It allows you 

to print or save your keys for safekeeping. It works on 

Windows 95, 98, ME, 2000, XP, Vista, 7, Server 2003, 

Server 2008, Office XP, Office 2003, and Office 2007 

family of products. It also has a community-updated con-

figuration file that retrieves product keys for many other 

applications. It has the ability to retrieve product keys 

from unbootable Windows installations.   An optional 

config file lets you pull a key stored in the registry for 

any software.  

 

 

Recuva (pronounced "recover") is a freeware Windows 

utility to restore files that have been accidentally deleted 

from your computer. This includes files emptied from 

the Recycle bin as well as images and other files that 

have been deleted by user error from digital camera 

memory cards, MP3 players or external drives. It will 

even bring back files that have been deleted from your 

iPod, or by bugs, crashes and viruses!  Recuva has as 

simple to use interface - just click 'Scan' and choose the 

files you want to recover.  It has a simple Windows like 

interface with List and Tree view and can be run from a 

USB thumb drive.  It's fast, tiny and takes sec-

onds to run! 

 

 

The Windows 7 Product Guide provides a detailed 

look at the many new and improved features in Windows 

7. The guide is designed as an accurate source of infor-

mation that can help you to understand how Windows 7 

Simplifies Everyday Tasks, Works the Way You Want, 

and Makes New Things Possible. This is not a help and 

how to guide. Rather, it provides an overview of the 

many exciting features in Windows 7 and pointers to 

more information  

 

 
$ 5.00  

http://majorgeeks.com/CleanDesktop_d6322.html
http://majorgeeks.com/CleanDesktop_d6322.html
http://majorgeeks.com/CleanDesktop_d6322.html
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Check our web site, http://www.tapcug.org, for any 

changes that may have occurred after the Data Line 

was sent to our web site. 

 

Flight Simulator SIG:  Curtis Poree, e-mail: 

dustoff_2@msn.com / Neil Stahfest, e-mail: 

ncstahfest@msn.com.  

 

The next meeting of the Flight Simulator S.I.G. will be 

on the Tuesday, January 26, at 7:00 PM at the Pierce 

County Lakewood Branch Library.   

 

This month weôre going to look at navigation.  GPS 

(Global Positioning System) instruments with moving 

map displays have revolutionized the way we navigate 

airplanes.  We no longer have to identify radio beacons 

along our flight path and base our navigation on flying 

to or away from them.  With GPS all we need to do is 

load the identification code of the destination airport 

into the device and a path will be drawn on the display 

leading us straight to it.  Advanced features show us the 

terrain along our flight, including bodies of water and 

mountains.  The newest GPS devices are accurate 

enough to guide us into small airports in reduced 

visibility without assistance from ground based 

devices.  Weôll see how this can be applied to 

Microsoft Flight Simulator and look at some examples. 

If you got some cool flight simulator program or 

hardware for Christmas, youôre invited to demonstrate 

or describe it to the rest of us. 

 

Bring a flash drive or a blank CD to make copies of the 

files I will demonstrate. 

 

If you're having a problem with Flight Simulator or 

want to know how to get started, bring questions.  We 

welcome people new to flight simulation and visitors at 

our meetings.  Although most of our discussions have 

been about Microsoftôs flight simulators, weôre always 

interested in hearing about other flight simulator 

programs.  If you have friends who might be interested 

in flight simulation, invite them to join us. 

 

Graphics/Scanner SIG: Barbara Grant, SIG Leader,  

Email: DL604@comcast.net 

We meet on the fourth Monday of the month 6:30 PM 

at the Lakewood Community Center computer lab. The 

next meeting will be January 25th.  

 

We have been discussing a few things regarding 

graphics; layering, cloning, and inserting pictures into 

other programs. The lab computers only use the Picasa 

photo editing program and I have other programs 

including Photoshop, Paint Shop, and Arc Soft which 

all edit graphics.  Each of them has a particular feature 

that I enjoy using and often switch back and forth to 

enhance what I am working on. 

 

There is a co-leader on this SIG and I am sincerely 

hoping that she, Doris, will be able to fill in where I am 

deficient.  Come on down, we can learn together. 

 

Linux SIG: Joel Carlson, 253-549-2692; e-mail: 

Fox7777@CarlsonCo.net,  

 

The Linux SIG meeting is on the 3rd Tuesday of the. 

 

Doors open by 6:30 PM for setup. Super fast T-1 

internet connections available. 

 

We will look at the new released Linux distributions 

including Mepis Linux 7.00 (which runs on Debian & 

Kubuntu and adds improvements), PCLinuxOS 2007 

(which is well suited to new users), OpenSUSE 11.0 

with One Click Software Install, Puppy Linux 4.0 for 

old/low capacity computers, flash drives, etc, Kubuntu 

8.04 & Fedora 9. We will explore Virtual Private 

Networks (VPN), such as OpenVPN, virtual online 

meetings using Gizmo or Skype and Speech 

Recognition, such as XVoice. 

 

Linux is the revolution that is becoming the computer 

operating system of the future! Say good bye to 

expensive proprietary operating systems, viruses, 

worms, crashes, forced upgrades, infuriating popups & 

get a better, complete Linux operating system with all 

the applications you need for a very affordable price. 

 

Now is the time to make the move to Linux. We 

welcome you to join us. See http://www.Linux-Now.us 

WIN XP/New Users: Paul Duhay, SIG Leader, 584-

6358, email: pduhay@sbcglobal.net 

 

Meets on the second Monday of the month, 5:30 - 7:30 

pm at the Lakewood Community Center Computer 

Lab. The next meeting will be January 11th. 

 

The WIN XP/New Users SIG meetings will cover the 

Special Interest Groups (SIG)  

O c t o b e r  J a n u a r y  2 0 1 0  
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The Help Line  

 The following TAPCUG members have generously 

offered to serve as resources for other members in need of 

assistance with the programs listed. This service is free, 

but please respect their time, and use your manuals or the 

software vendor information line when recommended 

Call or E-mail your questions: 
 

A=Anytime D=Daytime E=Evening W=Weekend 

 

Where no time has been indicated, it is suggested you not 

call before 10 am or after 9 pm. 

 

 

 Word Processing(most): Maggie Smith        537-5494 

 E-mail: maggiebs@harbornet.com   A 

 

 

 Linux support: Joel Carlson 

 E-mail fox7777@CarlsonCo.net 

 

 John Wickliffe 

 E-mail: johnwickl@comcast.net  

 

 

 MS Word:  Maggie Smith          537-5494 

  E-mail: maggiebs@harbornet.com   A 

  

 

 

To make changes or add your name to this list,  

e-mail Maggie at maggiebs@harbornet.com 

REMINDER TO ALL SIG LEADERS  
This is a reminder to all SIG Leaders. The 

quarterly SIG reports for October, November 
and December are due. Please send to 

Neil Stahfest: ncstahfest@msn.com 
or bring to the next General Meeting.  

Thank you. 

basics of computer operation, including file 

management, Internet concepts, and application software 

(word processing, etc.). This SIG is open to any 

new or intermediate user who wants to 

begin to unravel the mysteries of 

their own computer. 

 

 

J a n u a r y  2 0 1 0  

 

Wisdom 

The wisest 

mind has 

something yet 

to learn. 
 

George Santayana 

Linux SIG  
The January 19, 2010 Linux SIG meeting will be at 

the Lakewood Computer Clubhouse, <http://

Lakewood Computer Clubhouse.us/ > 8601 104th St SW, 

Lakewood, WA 98498, same time on the 3rd Tuesday of 

the month.  

 

We will try this much larger venue out because our 

attendance is growing.  If you are going West on 

Washington Blvd SW from Gravelly Lake Dr SW, take 

the first right on Interlaken and turn left on 104th.  

 

If you are coming South on Hipkins Road SW from 

Steilacoom Blvd SW, turn right on 104th. For details, see 

http://Linux-Now.us  

http://lakewoodclubhouse.us/
http://Linux-Now.us%20


Page 6 

SEPTEMBER  2008  D at a  L i n e  O c t o b e r  J a n u a r y  2 0 1 0  

Discovering Windows 7 ð Part 1  
by Neil Stahfest  

Tacoma Area PC User Group 
 

Last summerôs pre-release date order offer for Windows 7 
was too good a deal for me to pass up.  I canôt remember the 

last time Microsoft sold copies of its computer operating 

system for less than $50.  Maybe it was DOS 5.0? 

 

The upgrade from Vista to Windows 7 on my laptop PC was 

easy.  I wonôt go into the details at this time.  I would just 

suggest  that if youôre going to use the upgrade path from 

Vista to Windows 7; run the Windows 7 Advisor to identify 

any potential hardware or software problems, defrag drive C, 

run your anti-virus program and then disable or remove it 

before you start the upgrade.  Oh, and it wouldnôt be a bad 

idea to make a copy of your important files (pictures, 

documents, etc.) on an external device before you start.  Just 

to be safe. <S> 

 

Now, leaping ahead to actually using Windows 7, if you are 

familiar with Windows Vista your initial impression will be 

that it looks similar.  If you are used to Windows XP the 

differences will be more apparent.  The taskbar has a round 

Windows Start Button and all the icons immediately to the 

right of it represent programs that you can start with one 

mouse click.  The icons probably look bigger than you are 

used to seeing, it makes them easier to see.  There is a 

control setting that allows you to make them smaller.  The 

icons on the right had side of the task bar, the ñNotificationò 

area, represent various controls and activities that 

automatically start whenever you turn on the computer. 

 

When you click on the Windows Start Button, youôll notice 

that there is a Shut Down button in the lower right corner of 

the Start Menu (circled in red in the picture below).  The 

shut down sequence has been reduced to two key presses 

(Start button plus Shut Down button). Press on the little 

triangle to the right of the Shut Down button for more 

options (like Restart).   

 

Also notice that there is a ñsearch boxò to the left of the Shut 

Down Button (circled in blue).  Try typing key words or 

phrases here to look for files or information.  Windows 7 

will start suggesting solutions to your search almost as fast 

as you can type.  You can even use this to find controls that 

you would normally go to the Control Panel for (like finding 

and changing file associations or display settings).  Donôt see 

what you are looking for?  Weôll examine file searches in 

greater depth in the near future. 

 

Is there an icon on your desktop that starts a program that 

you use frequently?  Right click on the icon and select ñPin 

to Taskbarò from the menu that appears.  Now you can 

remove the icon from your desktop (hopefully cleaning up 

its appearance) and start the program with just one click on 

the Taskbar icon.  You can fit a surprising number of icons 

on the Taskbar. When there are too many icons to fit on the 

Taskbar, a second row will be created (accessible through a 

scroll bar). 

 

Before we leave the subject of the Taskbar, Windows 7 has a 

new feature that allows you to preview open files.  I have 

two open Microsoft Word documents.  Notice in the example 

shown below, that the icon for Word documents appears to 

have second icon behind it (circled in red).  By hovering my 

mouse pointer over the icon I can see a preview of both 

documents.  If I point at one of the preview images and click, 

it will be maximized. 

 

Want to look at both documents side by side?  Put your 

mouse pointer at the top of the document window and drag it 

to one side of your desktop. When the mouse pointer touches 

the side of the desktop, the document window will snap to 

fill half of the screen.  Now open your second document.  

Point at the top of the document window and drag it to the 

other side of the screen. When the pointer touches the side of 

the screen, the document will snap to fill the other half of the 

screen.  You can do this with pictures, spreadsheets, virtually 

any kind of file or folder.  If you do this with file folders, 

you can drag files from one folder to another. 

 

At this point I think youôre starting to see how some things 

have changed in Windows 7.  These donôt appear to be 

changes for the purpose of making changes but changes that 

actually enhance Windows.   My impression is that the new 

Windows is faster, more useful, prettier and smaller.  Yes, 

smaller!  Windows 7 actually takes less space on my hard 

drive than Windows Vista. 

 

Next month, weôll look at more Taskbar and Start menu 

improvements. 
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http://www.WorldStar.com  
 

Which services can I disable in 

Windows? 

First, you will want to have a restore 

point already created, so I will wait 

here while you do that, in case you 

haven't already done so. 

 

Done? Okay, great, let's get going on 

disabling some of the services on 

your computer so you can save some 

disk space and allow your computer 

to run a little bit smoother. 

 

First, click Start, Control Panel. 

Now, choose the Administrative 

Tools link (XP users will have to 

click on "Performance and 

Maintenance" first, then 

"Administrative Tools", Windows 

Vista and 7 users need only type 

"Administrative  Tools" into their 

search bar). Once there, click on 

Services and a list of all the services 

installed on your computer will 

come up. You can maximize the 

window, so you can see the status of 

each service. 

 

The first column contains the 

complete description of the service. 

Run your mouse pointer over the 

words so you can see the whole 

description written out. The next 

column is the status of each service. 

If it says "Started," that means that 

particular service is presently 

running. Next, you see the Startup 

Type, which tells you if the service 

starts automatically when you boot 

up your computer or 

if it has to be done 

manually. Some 

services may also be 

disabled. The next 

column is just telling 

you how you logged on for each 

service, whether it be through your 

local system or by a network service. 

 

Now, we're getting to the good part. 

The following services are ones that 

can be safely disabled, while still 

allowing your computer to run 

normally. Disabling some of these 

services will help you save some of 

your disk space, which is always a 

great thing! 

 

Disabling a service is pretty easy to 

do, but do it with caution as to make 

sure you don't hit the wrong thing. 

Just highlight  the service you want 

to turn off and right click  on it, 

choosing "Properties". A service 

sheet will come up for that service 

and you'll want to look under the 

general tab. Here, you can choose to 

stop the service or turn it back on 

(either automatically or manually). If 

you have XP, once you highlight the 

service, blue links will show up off 

to the left that say Stop or Restart the 

service. You can click on those to do 

the same thing as going into the 

Properties menu. 

 

Okay, here's the list you've been 

waiting for: 

 

Alerter:  Only alerts you of 

administrative alerts. You don't need 

them. 

 

Application Management:  
Processes installation requests for 

Intelli-mirror 

programs. Don't 

even know what 

those are? That's 

why you can 

disable it. 

 

 

ClipBook:  Allows ClipBook Viewer 

to store information and then share it 

with remote computers. You don't 

really need to do that, do you? 

 

Computer Browser: Works with 

networks and if you don't have a 

network, you don't need it. 

 

Distributed Transaction 

Coordinator:  

 Works with databases, message 

queues and file systems of networks. 

Once again, if you don't use a 

network, you can disable this. 

 

Error Reporting Service: All this 

does is send a crash report to 

Microsoft. They don't need to know, 

do they? 

 

Indexing Service: Indexes files and 

provides quick access to those files. 

This is another network use, so you 

can disable it. 

 

Internet Connection Firewall 

(ICF):  Involves Internet Connection 

Sharing and is just another network 

use. 

 

Logical Disk Manager/Logical 

Disk Manager Administrative:  
This service deals with adding drives 

to your system. If you're not going to 

be doing that, you can disable this 

one. 

 

Machine Debug Manager: Works 

with Visual Studio debugging. You 

probably won't use it. 

 

Messenger: Sends Alerter messages 

between the clients and servers. 

Another network service you 

probably won't need. 

 

Net Logon: Account authentication 

for network domains. Don't need this 

one either. 

 

NetMeeting Remote Desktop 

Sharing.Network DDE DSDM: 

(Continued on page 8) 
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Allows other authorized users to 

access your computer through 

NetMeeting. Once again, if you don't 

have a network or have no need to 

allow other users on your computer, 

you can disable this one. 

 

Remote Desktop Help Session 

Manager/Remote Access Auto 

Connection Manager: This one is 

the same as the above. 

 

Secondary Logon: Enables starting 

processes under other credentials, 

which is not necessary. 

 

SSDP Discovery: Locates UPnP 

devices on a home network. Sound 

confusing? That's why you can 

disable it. 

 

TCP/IP NetBIOS Helper: You'll 

only need this if you use NetBIOS 

for a local network. 

 

Telnet: Allows remote users to log 

on to your computer and run 

programs. I'm sure you don't want 

other users to be able to telnet into 

your system, do you? Disable it! 

 

Terminal Services: Gives access to 

other users to be connected to one 

basic machine, as well as, desktop 

displays and other applications. You 

can shut this one down. 

 

Themes: If you don't use desktop 

themes, you don't need this one. If 

you do, keep it going. 

 

Windows Time: Synchronizes all 

systems on a network time. 

 

Workstation:  Same as above. 

 

Whew, that's a lot, huh? Just keep in 

mind that these are just suggestions 

and you don't have to turn off some 

of these services if you don't want to. 

Especially don't turn them off if you 

think you're going to be needing 

them again someday. But, at least 

going through the list of your 

services will help you to determine 

what's running on your computer 

that may not need to be. You may be 

surprised at all you can turn off to 

save you some computer space. 

 

Note: Make sure you do not turn off 

any services that are not on this list 

unless you are an advanced user and 

you are certain that turning them off 

will not hurt your computer's 

operation. 

C C C 

 

Today, we're going to do 

something a little different with 

this section! Below are three 

questions that I have been getting 

a lot of lately, so I thought I would 

just answer all of them at the same 

time. You will find each question, 

followed by its answer. They're 

just three quick and simple 

questions. Hope you don't mind! 

Question #1: What does the star in 

Gmail mean and how can I use this 

function in my own e-mail? 

 

First, let's begin with a brief 

explanation of what Gmail actually 

is, just in case some of you aren't 

sure. Gmail (which can be found at 

www.gmail.com) is Google's version 

of an e-mail program. It is one of the 

top free e-mail services online today, 

offering 2.8 GB of storage space and 

a very easy to use interface. 

 

With that said, one of the new 

features introduced in Gmail is 

"starring." By starring a message in 

Gmail, the user is able to place a 

graphic reminder next to an e-mail 

that may be a little more important 

than some of the others. With this 

feature, you no longer have to mark 

an e-mail as "Unread" to remind 

yourself that you need to deal with 

that e-mail ASAP. 

 

Instead, you just mark the e-mail 

with a star and it will help you to 

remember that you need to respond 

to that e-mail. To star a message of 

your own, just look for the white star 

graphic, located to the right of the 

checkbox for the message you would 

like to select. Click on it and the 

graphic will then become a yellow 

star to show that it has been starred. 

As you can see, it's a very handy 

feature! 

 

Question #2: I'm using Windows 

XP and sometimes when I turn off 

my computer, I get this message as 

it's shutting down: "This application 

failed to initialize, because the 

window station is shutting down." 

What does that mean and how can I 

make it stop? 

 

Basically, the only time you'll ever 

see that message displayed is when 

your computer is shutting down. 

Whether you told the computer to 

turn off or an installer program is 

restarting your computer for you, 

that's the only time it will come up. 

This error message is displayed, 

because an important program must 

be running while you are attempting 

to turn off your computer. Either that 

or a program has frozen while you're 

trying to shut down your computer. 

 

It is important you make sure that 

while you are installing new 

software, there are no other 

applications running on your screen 

at the same time. Also, when turning 

off your computer, it is important to 

make sure that all of the programs 

you are running have been closed 

down. If you follow those two tips, 

you should never have a problem 

with this error message again! 

 

Question #3: Can a USB drive be 

reformatted? If so, how? 

When you plug a USB drive (flash 

drive, etc.) into your computer, it 

will recognize the device as an 

external hard drive. Since it does 

that, the USB device can easily be 

(Continued from page 7) 
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formatted. However, USB drives do 

not work with Windows 95 or 

Windows 98, unless you install the 

correct drivers. 

 

To reformat your USB drive, double 

click on the My Computer  icon on 

your desktop and then find the icon 

of the USB drive you have plugged 

into your computer. Right click the 

correct USB drive and choose the 

Format option. You can then make 

any changes you want to the Options 

screen that appears and when you're 

done, just click on the Start button. 

Windows will then format your USB 

drive. However, reformatting your 

USB drive will delete everything on 

the drive and all of your data will be 

lost. So, make sure you remove any 

important documents and files from 

your USB device before you proceed 

on with the reformat process. That's 

all there is to it! 

 

There you go. Hope these answers 

help you all out! 

C C C 

 

Scrub Up Your Vista 

Did you know that metadata within 

your files can tell a lot about you? 

For example, your digital camera 

records data about when a picture 

was taken and what camera was 

used. Your documents and 

spreadsheets contain details about 

who created them and your music 

files are tagged with artist and album 

information. And the list can go on 

and on. So, with all of that 

information widely known on your 

computer, it's wise to clean them up 

a bit every once in awhile. That's 

right, it's time to give your Windows 

Vista files a scrub down! 

 

To "scrub" a file of unwanted 

metadata in Vista, simply follow 

these steps: 

 

1.) Open the file you want to clean in 

Windows Explorer. 

 

2.) Right click on the file's icon and 

choose Properties. 

 

 
 

3.) Under the Details tab, click 

Remove Properties and Personal 

Information . That will then open 

the Remove Properties dialogue box: 

 

 
 

At this point, you have two choices. 

The default option creates a copy of 

your file (using the original file 

name with the word "copy" 

appended to it) and removes all the 

properties it can change, based on 

the file type. Or, you can choose the 

second option, which selectively 

removes the properties from the file. 

If you see a checkbox next to a 

property, you can erase that 

property's current content. If there's 

no checkbox, the data is non-

removable. 

 

Make sure you use common sense 

when you're making your choice. 

The second option zeroes out the 

metadata, but it does nothing with 

the contents of the file itself. 

Therefore, the first option may be 

your best bet. Just take some time to 

think about all the files you have on 

your computer and what sort of 

information they may contain. Then 

scrub them up as you deem 

necessary. That's it! 

C C C 

 

Time to Clean Up 

Ever try to paste information into 

Excel from some other application? 

  

Did you get something that looks a 

bit strange? Maybe like thisé  

 

Looking to get rid of the garbage 

that came along with the 

information? (I just bet you are since 

the other options involve a lot of 

work along the lines of manually 

editing or entering all the dataé) 

 

Anyway, that's what I have to offer 

today - a way to get Excel to remove 

all the nonprintable characters from 

the text with one quick formula. 

 

(Continued from page 8) 
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Specifically, we're going to use the 

CLEAN formula toé wellé clean 

up the data. Give this a try in a new 

cell(s): 

 

=CLEAN( address of cell to clean) 

 

Yep - that's it. You use the formula 

on a set of cells and you get a new 

set of cells that have usable 

information. 

 

I found that I could drag the formula 

cell contents around without loosing 

the cell reference (so the text stayed) 

and I also did a copy / paste Excel 

had me choose how to paste. I chose 

values only and ended up with text 

in a cell just as I'd hoped when I 

pasted the data in the first place! 

 

I just wish that all cleaning could be 

this easyé 

C C C 

 

Ransomware 

I'm sure all of you have heard of 

worms, Trojans, adware, spyware 

and viruses, right? Those nasty little 

bugs are the reason for troublesome 

computer problems throughout the 

world. Well, today, I have a new 

type of attack to add to the list. This 

type of bug is called ransomware. 

Ransomware has been around for 

awhile in the computer world, but it 

hasn't really taken off until recently. 

 

So, what is ransomware, you ask? 

 

Well, ransomware is technically a 

program. It basically takes over your 

computer and then requires you to 

pay to get your system back to 

normal. Usually, it will infect your 

system through a bad Web site or via 

a pop up window, but it can also 

come in through an e-mail 

attachment or a download. Once 

your system is infected with the bad 

software, it will let you know right 

away. More than likely, you will see 

a screen come up that tells you what 

damage will be done to your 

computer if you don't pay in time. It 

will require you to pay in a certain 

way and in turn, you will be given a 

code to turn off the software and 

stop the damage from continuing. 

 

There are a couple well known 

ransomware programs currently in 

use around the Web. One is called 

Ransom.A. That program will tell 

you it will destroy one file every 30 

minutes until the ransom is paid. 

This program seems very bad, but in 

reality, it does no damage to your 

system. It is simply a scare tactic to 

get you to pay the fee. While this 

specific ransomware causes no 

damage to your system, there are 

several others that truly do what they 

say. Those programs can cause 

serious harm to your computer or 

they simply just embarrass the 

infected user by popping up 

pornographic material on their 

screen. 

 

No matter what the damage, it's 

important to protect your computer 

against these growing threats. The 

good news is you don't need to have 

any additional protection on your 

system to shield you from 

ransomware. If you keep your 

antivirus software up to date and 

have a good pop up blocker, you will 

remain safe from these threats. If 

your system should end up infected 

with one of these programs, do not 

panic and do not pay the ransom! It's 

best to run a full system scan with 

your antivirus software instead. The 

program can then be found and 

removed. If it's not removed, your 

antivirus company should give you a 

link to a Web site with removal 

steps. Until next time, stay safe out 

there, my friends! 

 

You don't have to pay the ransom! 

C C C 

 

Run As Administrator  

You know what I find frustrating? 

When I'm logged into Windows 

Vista or 7 as the administrator, but 

find that I still can't run something 

because it says that I need 

ñAdministrative Privilegesò. 

 

What gives? Aren't I the 

administrator already? 

 

Well, some programs like the 

Command Prompt, Task Scheduler, 

and Regedit which haven't been fully 

updated to work with Vista or 7, 

need elevated privileges in order to 

function properly. The good news is 

that there's a quick and easy way to 

run these programs as 

ñAdministratorò, and I'm going to 

show you how right now. 

 

Click Start and type in the name of 

the program in question that needs 

the admin privileges. I'll use the 

command prompt as my example. 

 

 
 

Once you have the program pulled 

up, just right -click on it and choose 

ñRun as administratorò.  

And there you have it!  You're the 

administrator! 

C C C 

 

What exactly is keystroke logging? 

I've heard it mentioned in your 

tips before, but I'm not quite sure 

what it is. Please explain! 

Basically, keystroke logging (also 

known as keylogging) is a method 

(Continued from page 9) 
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used to capture and record user 

keystrokes. It's often thought of in a 

negative sense, but it can be used for 

good as well. For example, 

keylogging can be used to track 

down certain computer system 

errors, to research how users interact 

with certain systems and it can even 

be used to check on employee 

productivity for certain tasks. 

Keylogging is also useful in law 

enforcement, as it provides a way to 

unlock passwords and encryption 

keys. 

 

Of course, keystroke logging is also 

a method used by hackers to get into 

another user's computer and steal 

information. That's the type we talk 

about the most in our computer tips, 

because we want to keep you safe at 

all times. There's really not that 

much to it though. If you have an 

antivirus program, a good firewall 

and some type of anti-spyware 

software on your computer, you will 

be safe from keystroke loggers. 

Those types of applications can stop 

keystroke loggers in their tracks so 

that your information stays 

protected. 

 

Back on the other side, there are two 

types of keystroke logging: hardware 

and software based. Hardware 

loggers come in three different 

types. First, there are the devices that 

are attached to the keyboard cable. 

They are inline devices and they are 

very easy to install, but they're also 

easily detected. Secondly, there are 

the devices that can be installed 

inside an actual keyboard. They are 

rather difficult to install, but once 

they're in, they are almost impossible 

to detect. Thirdly, there are 

replacement keyboards that already 

have the key logger built in. Those 

are obviously the easiest to work 

with and the logger is very hard to 

detect. 

 

The software loggers are basically 

set up to see how users interact with 

different software programs on a 

computer. Like I said before, they 

can be used to keep track of how an 

employee is performing and so on. 

There are several different types of 

software keylogging, including local 

machine software keyloggers, 

remote access software keyloggers, 

wireless keylogger sniffers and 

acoustic keyloggers. They are all 

used for different tasks and they all 

provide different results. 

 

As you can see, keystroke logging is 

used in a variety of ways and while 

it's used for both positive and 

negative aspects, it is a useful 

procedure. There's probably a lot 

more technical jargon I could bog 

you down with in terms of keystroke 

logging, but I think you get the gist. 

C C C 

bove the Table 

Have you ever created a table in MS 

Word at the beginning of a 

document, only to find that it was a 

mistake? I mean, since you began 

the document, you've probably 

redone the layout and some of the 

text just has to go above that table. 

 

But, of course, you're learning the 

hard way that MS Word isn't going 

to cooperate very easily. 

 

Every time you try to get to the top 

of the document (that is, above the 

table), you end up in the first cell or 

with an entire column highlighted. 

 

No matter what you do, you're stuck 

in that table! 

 

You can get the text below the table, 

but there's just no getting above it! 

 

Or is there? 

 

Don't give up on that table just yet. 

And by all means, don't delete it to 

start over! 

 

Try this quick little trick to get to the 

top. 

 

Use the key combination of Ctrl + 

Home and then (after releasing the 

keys), hit the Enter key. 

 

Voila! You've got a line above your 

table, with no starting over or 

frustration required! 

C C C 

Run Command in Vista 

Windows XP users are used to 

having their Run Command, but 

when Vista came out this function 

was condensed down into the 

Search Bar. It works basically the 

same, but there are purists out there 

that miss the Run Command, proper; 

as it originally was in XP. 

 

So let's learn how to bring it on 

back! 

 

Right-Click  the Start Button and 

choose ñPropertiesò Then select the 

Start Menu tab and click the 

ñCustomizeò button. 

 

About three quarters of the way 

down the list of customization 

choices, put a check next to the 

ñRun Commandò option, then click 

ñOKò  Ta'da! 

 

If you just want to skip permanence, 

then hit the Windows Key + r. That 

should bring up the Run Command 

right away. 

 

Run, Runner! 

C C C 

 

No More Indexing  
Did you know that Windows XP and 

Vista keep a record of all the files 

you have saved on your hard disk? 

Why do they do this? Well, it's 

basically used for when you do a 

search for a particular file or folder 

on your hard drive. Since they both 

(Continued from page 10) 
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remember everything you have, it 

makes this process go much faster. 

 

On the other hand though, there is a 

downside to this. Because your 

computer has to index all of the files 

you have stored on your hard drive, 

it slows things way down when just 

trying to find that particular one 

you're looking for. It will drag out 

the normal file commands, such as 

opening and closing as well. 

 

So, if you don't usually search for 

files on your hard drive in this way, I 

suggest turning the indexing feature 

off. It will speed things up so much 

for you. Hereôs how you do it. 

 

For Windows XP: 
1. Click on Start, Control Panel. 

(Note: You must be in the classic 

Control Panel view for this tip to 

work). 

2. Double click Administrative 

Tools

3.Double click Services. 

4. Double click Indexing Services. 

 
5. Click on Stop and then click OK .  

 

For Windows Vista: 
Almost the exact same process here, 

only instead of "indexing Services" 

you'll look for "Windows Search" . 

Stop that service and enjoy increased 

search speeds within Windows! 

 

 
 

Once you have the Indexing or 

Search option stopped, your 

computer will be able to find any of 

the files or folders you want to 

access much quicker. Everything 

will just work so much faster and 

you and I both know, you can't beat 

that! 

C C C 

Restoring Previously Opened 

Folders 
Are there folders you open up 

habitually every time you start up 

your computer? If so, did you know 

that you can set up your computer to 

open those folders automatically 

each time you boot up? Windows 

Vista users need only apply for this 

one! 

 

Here's what you need to do to make 

it happen: 

1.) First, open Windows Explorer  

or browse to any folder. 

2.) Next, select "Organize"  from 

the toolbar at the top of the window. 

3.) Click on Folder and Search 

Options and the following window 

will open up on your screen: 

(Continued from page 11) 

(Continued on page 13) 

http://www.worldstart.com/tips/tips.php/412


Page 13 

SEPTEMBER  2008  D at a  L i n e  

4.) Now, click on the View tab. 

5.) Check the option that says 

ñRestore previous folder windows 

on log on." 

6.) Click Apply  and then OK . 

 

Now, when you log off, restart or 

shut down Vista, it will 

automatically open the previously 

opened folders on the next boot. This 

is a great way to get a head start on 

what you were working on when you 

last left your system! Go forth and 

give it a shot! 

C C C 

Where'd My Downloads Go? 

Have you ever downloaded a file 

then couldn't find it? I usually 

download to my desktop or my 

downloads folder, but I do 

occasionally change folders when 

the files go over a certain size. 

 

If you can't find a downloaded file in 

the usual place, try to download 

again and you'll see the location 

under the "Save in" field. Most 

browsers remember where your most 

recent download was saved. Hit 

"Cancel" once you know the 

location. In Firefox, all you need to 

do to find your recent download is 

go to Tools>Downloads (also 

accessible by pressing Ctrl+J ) and 

right -click on the download in 

question and choose ñOpen 

Containing Folderò.  

C C C 

What is a blog? 

Want to expose your thoughts to the 

world? Share your favorite links? 

Shout out your political, religious, or 

personal beliefs? Well, a blog is the 

place to do it. It can be a soap box, a 

pulpit, a diaryðwhatever you want 

it to be. There are few rules and can 

be any size or shape. 

  

Blog is a portmanteau of "Web Log" 

and is a web site where you can post 

pictures, share links, make 

comments, and write whatever you 

want. Another neat aspect of 

blogging is that visitors can 

comment on the posts creating an 

interactive, collaborative space. 

Many have RSS feeds that notify 

you of new posts. 

 

Blogs make a big impact these days 

and are fastly becoming a valid news 

outlet. For example, bloggers 

exposed forged documents used in a 

news story causing the demise of a 

prestigious network anchorman. 

Some bloggers are even being 

recognized by the news 

establishment as legitimate 

journalists. Priests and pastors 

encourage and inspire with daily 

devotional posts. 

 

There's a blog for every interest, and 

if there isn't, you can create one. 

Basic blogs can be created for free, 

while more involved ones might 

require a hosting fee. 

 

For some lists of what's out there, 

check out these web sites... 

 

http://blogcatalog.com/ 

http://www.blogsearchengine.com/ 

http://www.blogarama.com/ 

 

So explore the "blogosphere", or 

jump in with your own blog spot. 

C C C 

 

Where'd My Downloads Go? 

Have you ever downloaded a file 

then couldn't find it? I usually 

download to my desktop or my 

downloads folder, but I do 

occasionally change folders when 

the files go over a certain size. 

 

If you can't find a downloaded file in 

the usual place, try to download 

again and you'll see the location 

under the "Save in" field. Most 

browsers remember where your most 

recent download was saved. Hit 

"Cancel" once you know the 

location. In Firefox, all you need to 

do to find your recent download is 

go to Tools>Downloads (also 

accessible by pressing Ctrl+J ) and 

right -click on the download in 

question and choose ñOpen 

Containing Folderò.  

C C C 

 

Firefox Toolbar Customizing 

Is your Firefox toolbar yawn-

worthy? Do you fall asleep 

sometimes just thinking about how 

lame it is? 

 

Well, wake up, because today we're 

going to snazz it up a bit! 

 

Just click 

View>Toolbars>Customize.  

 

Just drag and drop the features you 

want into Firefox's toolbar in any 

order you like to customize. You can 

add spaces, separators and adjustable 

spaces, too, so you can lay it out any 

way you like! 

 

Now that's cool!  
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TAPCUG ADS IN THE DATA LINE  

A 
s you can see, TAPCUG is offering space in our Data Line publication for business card 

size advertising by Computer oriented businesses or Computer educational entities that are 

consistent with the aims of our club. The cost is very reasonable. It is $10 per month for a 

single insertion or $75 for a yearly rate. Larger size ads are proportionately priced. 

Printing is a very large club expense and it is the Board of Directors hope that some of the costs can 

be offset. We urge our members to discuss our ad campaign with prospective advertisers. We print 

300 copies per month and send copies, not only to our members, but also selected clubs and 

dignitaries that are in close proximity to the Tacoma Area PC Users Group. We ask that black and 

white copies be submitted to the Data Line Editor no later than the 15th of the month. Checks should 

be made out to TAPCUG. 

Advertise Here! 
 

Rates: $10 Per issue, s ingle card size 
 $20 Per issue, double card size 
Special: $75 (12 Issues) single card 
 $150 (12 Issues) double card 
 
*Al l  ads must be Computer related 
*Copy must be submitted by the 15th 
*Ad size is standard business card 
 
Single Business Card, �� �� �� �� �� �µ���; �� �� �µ 
�' �R�X�E�O�H���%�X�V�L�Q�H�V�V�� �&�D�U�G�� �� �� �µ�� �; �� �� �µ 
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